ChemiDoc™ MP Imaging System
with Image Lab Software

Instrument Guide

Version 6.0
ChemiDoc™ MP Imaging System with Image Lab Software

Instrument Guide

Version 6.0
Bio-Rad Technical Support Department
The Bio-Rad Technical Support department in the U.S. is open Monday through Friday, 5:00 AM to 5:00 PM, Pacific time. Go to www.consult.bio-rad.com for worldwide technical support.

Phone: 1-800-424-6723, option 2
Web: www.consult.bio-rad.com
Email: Support@Bio-Rad.com (U.S./Canada only)

For technical assistance outside the U.S. and Canada, contact your local technical support office.

Notice
No part of this publication may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopy, recording, or any information storage or retrieval system, without permission in writing from Bio-Rad.

Bio-Rad reserves the right to modify its products and services at any time. This user guide is subject to change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors or omissions, or for any damage resulting from the application or use of this information.

Credits
1. Image Lab software is based in part on the work of the Qwt project (http://qwt.sf.net).
2. Image Lab software is based in part on the work of the CImg project (http://cimg.sourceforge.net/). See license for details at: http://www.cecill.info/licences/Licence_CeCILL-C_V1-en.html
3. Image Lab software is based in part on the work of the Independent JPEG Group (http://www.iwjg.org/)

GelStar is a trademark of FMC Corporation. IRDye is a trademark of LI-COR Biosciences. Alexa Fluor, Coomassie Fluor, Qdot, OliGreen, PicoGreen, Pro-Q, SYBR, and SYPRO are trademarks of Life Technologies Corporation. Coomassie is a trademark of BASF Aktiengesellschaft. Cy2 and Cy3 are trademarks of GE HealthCare. DyLight and Krypton are trademarks of Thermo Fisher Scientific Inc. GelGreen and GelRed are trademarks of Biotium, Inc. Slo-Blo is a trademark of Littelfuse, Inc. Mitsubishi is a trademark of Mitsubishi Companies.

Bio-Rad Laboratories, Inc. is licensed by Life Technologies Corporation to sell SYPRO products for research use only under U.S. Patent Number 5,616,502.
Criterion Stain Free gels are covered by U.S. Pat. No. 7,569,130.
Copyright © 2017 Bio-Rad Laboratories, Inc.
# Table of Contents

## Safety and Regulatory Compliance

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Important Safety Information</td>
<td>7</td>
</tr>
<tr>
<td>Warranty</td>
<td>8</td>
</tr>
<tr>
<td>General Precautions</td>
<td>8</td>
</tr>
<tr>
<td>Regulatory Notices</td>
<td>9</td>
</tr>
<tr>
<td>Alert Icons</td>
<td>10</td>
</tr>
<tr>
<td>Cautions</td>
<td>10</td>
</tr>
<tr>
<td>Warnings</td>
<td>11</td>
</tr>
<tr>
<td>Instrument Safety Warnings</td>
<td>11</td>
</tr>
<tr>
<td>Notice</td>
<td>12</td>
</tr>
<tr>
<td>Power Safety Information</td>
<td>12</td>
</tr>
<tr>
<td>Voltage Setting Information</td>
<td>12</td>
</tr>
<tr>
<td>Fuses</td>
<td>12</td>
</tr>
</tbody>
</table>

## Chapter 1  Introduction

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChemiDoc MP Imaging System</td>
<td>14</td>
</tr>
<tr>
<td>System Components</td>
<td>14</td>
</tr>
<tr>
<td>CCD Camera and Lenses</td>
<td>14</td>
</tr>
<tr>
<td>Universal Hood III</td>
<td>15</td>
</tr>
<tr>
<td>Image Lab Software</td>
<td>15</td>
</tr>
<tr>
<td>Emission Filters</td>
<td>15</td>
</tr>
<tr>
<td>Optional Accessories</td>
<td>16</td>
</tr>
<tr>
<td>Printer</td>
<td>16</td>
</tr>
<tr>
<td>Conversion Screens</td>
<td>16</td>
</tr>
<tr>
<td>Optional Light Sources</td>
<td>16</td>
</tr>
</tbody>
</table>
Table of Contents

Applications.................................................................................. 17
Technical Specifications................................................................. 18
Workflow ......................................................................................... 19
For More Information....................................................................... 20

Chapter 2  Acquiring Images............................................................ 21
Creating Protocols ........................................................................... 22
Using Signal Accumulation Mode (SAM). ....................................... 24
Accessing Protocol Setup Screens ............................................... 25
Choosing an Application ................................................................ 26
Configuring a Single-Channel Protocol ........................................ 26
Multichannel Protocols ................................................................. 29
Configuring a Multichannel Protocol .......................................... 29
Configuring Analysis Settings ....................................................... 34
Configuring Output Settings ......................................................... 34
Positioning the Gel ........................................................................ 35
Running a Protocol with SAM ....................................................... 37
Saving SAM Images ....................................................................... 38
Setting Up a Custom Application ................................................. 38
Editing a Protocol ......................................................................... 40

Chapter 3  System Calibration .......................................................... 41
Recalibrating the Imager ................................................................. 42

Appendix A  Maintenance ................................................................. 45
UV Transilluminator Lamp and Starter Replacement ..................... 45
Fuse Replacement .......................................................................... 47

Appendix B  Troubleshooting ............................................................ 49

Appendix C  Accessories ................................................................. 51
Calibrating Accessories ................................................................ 51
Installing Optional Accessories .................................................... 51
Table of Contents

- Epi Light Modules ................................................................. 51
- UV/White Light Conversion Screen ........................................... 52
- XcitaBlue Conversion Screen .................................................. 54
- Gel Alignment Template Kit ..................................................... 57
- Ordering Information ............................................................... 60

Appendix D Using Bio-Rad Stain-Free Technology ......................... 63
- Stain-Free Workflow .............................................................. 64
- Electrophoresis with Stain-Free Gels ........................................ 65
- Imaging Gels ................................................................. 65
- Imaging Blots ................................................................. 66
Table of Contents
Safety and Regulatory Compliance

Important Safety Information

Please read these instructions before attempting to operate the ChemiDoc™ MP imaging system.

This instrument is suitable for research use only. It must be used, therefore, only by specialized personnel who know the health risks associated with the reagents that are normally used with this instrument.

Use of the ChemiDoc MP imaging system involves UV illumination. Proper precautions must be taken to avoid eye and skin exposure to the UV radiation. This instrument is meant for use only by trained personnel who know the health risks associated with the UV radiation normally used with this instrument. The acrylic shield provides some UV protection. However, it does not guarantee complete protection, and it is designed to shield only the person working in front of the imager.

WARNING! Use of the acrylic screen does not guarantee the user protection from UV radiation. The use of protective eyeglasses, mask, and/or gloves is strongly recommended.
Safety and Regulatory Compliance

Warranty

The ChemiDoc MP imaging system is warranted against defects in materials and workmanship for one year. If any defect occurs in the instrument during this warranty period, Bio-Rad Laboratories, Inc. will repair or replace the defective parts at its discretion without charge. The following defects, however, are specifically excluded:

- Defects caused by improper operation
- Repair or modification done by anyone other than Bio-Rad Laboratories, Inc. or the company’s authorized agent
- Use of spare parts supplied by anyone other than Bio-Rad Laboratories, Inc.
- Damage caused by accident or misuse
- Damage caused by disaster
- Corrosion caused by improper solvents or samples

General Precautions

- Read the user guide carefully.
- The instrument must be used only for the intended purpose of gel documentation in research laboratories.
- The instrument must be connected to a grounded power source line and protected by a circuit breaker.
- Do not pour liquids directly on or inside the instrument.
- Switch off all lights on the instrument immediately after use.
- Clean the transilluminator sample area after use.
Regulatory Notices

The ChemiDoc MP imaging system is designed and certified to meet EN 61010, the internationally accepted electrical safety standard, EMC regulations, and TUV requirements. Certified products are safe to use when operated in accordance with this user guide. Do not modify or alter this instrument in any way. Modification or alteration of this instrument will

- Void the manufacturer's warranty
- Void the regulatory certifications
- Create a potential safety hazard

Caution: Bio-Rad Laboratories, Inc. is not responsible for any injury or damage caused by use of this instrument for purposes other than those for which it is intended or by modifications of the instrument not performed by Bio-Rad Laboratories, Inc., or an authorized agent.
Alert Icons

Alert icons in this guide call attention to caution and warning paragraphs. Each icon indicates the type of hazard addressed.

Table 1. How alert icons are used in this guide

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="General" /></td>
<td>Indicates a potential hazard requiring special attention. This icon is used when the hazard or condition is of a general nature.</td>
</tr>
<tr>
<td><img src="image" alt="Electrical hazard" /></td>
<td>Indicates a potential hazard requiring special attention when you are working with electricity or electrical equipment.</td>
</tr>
<tr>
<td><img src="image" alt="Extreme heat and flammable materials" /></td>
<td>Indicates a potential hazard requiring special attention when you are working with extreme heat and flammable materials.</td>
</tr>
<tr>
<td><img src="image" alt="Radiation hazard" /></td>
<td>Indicates a potential hazard requiring special attention when you are working with UV radiation.</td>
</tr>
</tbody>
</table>

Cautions

A caution in this guide alerts you to take or avoid a specific action that could result in loss of data or damage to the instrument. A caution can also indicate that, if the precaution against a potential hazard is not taken, minor or moderate injury might occur.

Example

Caution: With the exception of cleaning or replacing light bulbs, refer all servicing to qualified Bio-Rad personnel or their agents.
Warnings

A warning in this guide precedes an action that, if not followed correctly, could cause serious injury or death to the operator, serious or total loss of data, or serious damage to the instrument.

Example

**WARNING!** Use of the acrylic screen does not guarantee the user protection from UV radiation. The use of protective eyeglasses, mask, and/or gloves is strongly recommended.

Instrument Safety Warnings

Before you operate the instrument, carefully read the contents of Table 2.

Table 2. Safety cautions and warnings for the instrument

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td><strong>Caution:</strong> With the exception of cleaning or replacing light bulbs, refer all servicing to qualified Bio-Rad personnel or their agents. If you experience technical difficulties with the instrument, contact Bio-Rad to schedule service. The instrument should not be modified or altered in any way. Alteration voids the manufacturer’s warranty and might create a potential safety hazard for the user.</td>
</tr>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td><strong>Caution:</strong> If the case interlock is defeated, there is a possibility of UV-B radiation hazard due to UV-B light exposure. Exercise caution when servicing the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td><strong>Caution:</strong> Disconnect the AC power cord before removing the instrument cover.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Icon" /></td>
<td><strong>Warning:</strong> This instrument must be connected to an appropriate AC voltage outlet that is properly grounded.</td>
</tr>
</tbody>
</table>
Notice

The ChemiDoc MP imager is intended for laboratory use only. This device is meant for use by specialized personnel who know the health risks associated with reagents normally used in electrophoresis. Bio-Rad Laboratories, Inc. is not responsible for any injury or damage caused by use of this instrument for purposes other than those for which it is intended, or for instrument modifications not performed by Bio-Rad Laboratories, Inc. or an authorized agent.

Power Safety Information

Voltage Setting Information

The universal hood for the ChemiDoc MP imager has a power supply that automatically chooses the correct voltage for your country or region.

Fuses

The universal hood for the ChemiDoc MP imager has two user-serviceable fuses, F1 and F2, which are located on the bottom rear panel and are a part of the power entry module. See Fuse Replacement on page 47 for more information.
1 Introduction

The ChemiDoc™ MP imaging system contains a charge-coupled device (CCD) camera to capture images in real time and enable you to accurately position your sample and generate optimized image data.

The ChemiDoc MP uses a new generation lighttight enclosure (the universal hood III), which contains built-in UV and white light illumination as well as available red, green, and blue epi LED light sources. The imaging system features a dynamic flat fielding technology for superior image uniformity and accurate quantitation.

The imaging system includes the ChemiDoc MP instrument connected to a separate computer running Image Lab™ software.

Using Image Lab software you can create protocols that specify options for single, repeatable workflows that do the following:

- Control the ChemiDoc MP during image capture
- Optimize acquisition applications
- Analyze results
- Produce reports and other output

For more information about Image Lab software, see the Image Lab Software User Guide.
ChemiDoc MP Imaging System

The ChemiDoc MP imaging system is a high-resolution gel documentation system that allows fast, easy quantitation of gels and blots. Position your sample inside the instrument and follow the on-screen steps in Image Lab software to run a protocol with a single click. You can customize applications in an existing protocol or create a new protocol using the options included in Image Lab software.

The imaging system also offers sensitive chemiluminescent detection. The system includes a supersensitive CCD camera that is deeply cooled for faint-sample detection and for accurate quantitation of image data.

Features include

- Smart, application-based protocol setup using Image Lab software, which assists by presenting appropriate filter and illumination sources for imaging applications that require excellent sensitivity
- Exceptional sensitivity and a dynamic range greater than four orders of magnitude
- Flexibility to image chemiluminescent, fluorescent, and colorimetric samples with dynamic flat fielding specific to each application*

System Components

CCD Camera and Lenses

The camera in the ChemiDoc MP imager is placed on top of a lighttight enclosure (the universal hood) for capturing images. The camera comes with a motorized zoom lens (MZL) that allows remote adjustment of the lens control functions (zoom, focus, and iris).

A patented* software algorithm controls the MZL, giving the user automatic image focus once an initial calibration is performed during system installation. Refer to Technical Specifications on page 18.

* U.S. patent 8913127
A +1 diopter lens is factory installed to allow the entire sample stage to be visible. This lens should always remain on the MZL assembly.

**Universal Hood III**

The universal hood III captures fluorescent and chemiluminescent images without using a photographic darkroom. The enclosure has built-in white light epi-illumination and UV transillumination. For easy sample loading, the UV transilluminator is located in the drawer of the universal hood and can be accessed from the front of the enclosure. When not imaging, the lights in the darkroom enclosure turn off automatically.

The universal hood III has touchpad buttons to perform various functions. However, Image Lab software controls all of these functions remotely, removing any requirement for manual control of the lens and lights. Running a protocol overrides touchpad input.

**Image Lab Software**

The imager ships with a full version of Image Lab software. In addition to controlling the imager, image capture, and optimization, Image Lab software can be used to annotate and document images, analyze molecular weights when imaging protein and nucleic acid gels, and determine quantitation and purity of samples.

You can print all or a subset of your data in a report. Alternatively, you can export the data to other software, such as Microsoft Office programs, for further analysis or presentation options.

**Emission Filters**

The universal hood III can hold up to four different emission filters for fluorescent applications. No filter is required to image chemiluminescent samples.

There are six different filter wheel positions: four for the emission filters, one for a calibration disc, and one that must be open for chemiluminescent applications. A standard filter, included in the installation kit, is used for colorimetric (white light) applications.
Optional Accessories

Bio-Rad Laboratories, Inc. offers a selection of optional filters and illumination sources. See Ordering Information on page 60 for a complete listing of accessory filters, UV light sources, optional parts, and replacement parts.

Printer

For your convenience, Bio-Rad offers an optional USB printer for use with the ChemiDoc MP system: the Mitsubishi thermal printer (catalog #1708089).

Conversion Screens

White Light Conversion Screen

The white light conversion screen is a phosphor screen that produces white light transillumination when placed on top of the UV transilluminator.

XcitaBlue Conversion Screen

The optional XcitaBlue™ screen kit (catalog # 1708182) converts UV to blue light, which enables you to visualize a DNA sample while protecting it from UV damage.

Optional Light Sources

Red LED Module

The optional red LED module kit contains the emission filter and excitation source for fluorescent applications. Instructions are also included.

Green LED Module

The optional green LED module kit contains the emission filter and excitation source for fluorescent applications. Instructions are also included.

Blue LED Module

The optional blue LED module kit contains the emission filter and excitation source for fluorescent applications. Instructions are also included.
Applications

The ChemiDoc MP imager is capable of running protocols to image blots that use various detection reagents for chemiluminescent, colorimetric, and fluorescent applications. It can also image singleplex, multiplex, and stain-free gels and blots. Contact Bio-Rad technical support to determine whether your gel or blot can be imaged on this instrument.
# Technical Specifications

## Applications

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Chemiluminescence</td>
<td>Yes</td>
</tr>
<tr>
<td>Fluorescence*</td>
<td>Yes</td>
</tr>
<tr>
<td>Colorimetry</td>
<td>Yes</td>
</tr>
<tr>
<td>Gel documentation</td>
<td>Yes</td>
</tr>
</tbody>
</table>

## Hardware Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum sample size</td>
<td>Length: 28 cm&lt;br&gt;Width: 36 cm</td>
</tr>
<tr>
<td>Maximum image area</td>
<td>Length: 26 cm&lt;br&gt;Width: 35 cm</td>
</tr>
<tr>
<td>Maximum image area for standard, UV-excited gels</td>
<td>Length: 25 cm&lt;br&gt;Width: 26 cm</td>
</tr>
<tr>
<td>Excitation source</td>
<td>Trans-UV and epi-white are standard (302 nm included, with 365 nm available as an option).&lt;br&gt;Optional trans-white conversion screen.&lt;br&gt;Optional XcitaBlue™ UV/blue conversion screen. Blue, green, and red epis.</td>
</tr>
<tr>
<td>Detector</td>
<td>Supercooled CCD</td>
</tr>
<tr>
<td>Pixel size (H x V in microns)</td>
<td>6.45 x 6.45</td>
</tr>
<tr>
<td>Cooling system</td>
<td>Peltier cooled</td>
</tr>
<tr>
<td>Camera cooling temperature</td>
<td>–30°C controlled</td>
</tr>
<tr>
<td>Filter selector</td>
<td>6-position filter wheel&lt;br&gt;1 without filter for chemiluminescence</td>
</tr>
<tr>
<td>Emission filters</td>
<td>1 included (standard)&lt;br&gt;3 optional (530, 605, 695)</td>
</tr>
<tr>
<td>Dynamic range</td>
<td>&gt;4.0 orders of magnitude</td>
</tr>
<tr>
<td>Pixel density (gray levels)</td>
<td>65,535</td>
</tr>
</tbody>
</table>
Following are the basic steps for acquiring, analyzing, and archiving an image using the ChemiDoc MP imaging system and Image Lab software:

1. Select a protocol or customize a new one.
2. Position the gel or blot to be imaged.
3. Run your selected protocol.

* Using the optional XcitaBlue kit (catalog # 1708182) is highly recommended if performing preparative DNA applications with blue excitable stains. The UV to blue conversion screen allows you to visualize DNA samples while protecting against UV damage.
4. View the displayed results.
5. Optimize the analysis.
6. Generate a report.
7. Save or export the results.

For More Information

For instructions about assembling and calibrating the ChemiDoc MP imager, refer to the ChemiDoc MP Installation Guide in your ChemiDoc MP installation kit.

For information about installing Image Lab software, see Setting up Image Lab Software in the Image Lab Software User Guide.

To recalibrate your imager when you acquire new accessories, see Chapter 3, System Calibration.
2 Acquiring Images

Image Lab™ software runs configurable application-based, single-channel and multichannel protocols for sample imaging. In a single acquisition, a protocol runs a combination of settings for acquiring one or more images, analyzing them, and creating a customized report.

Protocols can be retrieved, revised, and reused.

Images you acquire at high resolution result in large files. For this reason, Bio-Rad recommends archiving images by exporting the files to network file server or to removable storage media.

For more detailed information about protocols, see the Image Lab Software User Guide.
Creating Protocols

Creating a protocol consists of configuring acquisition, analysis, and output settings. Analysis and output settings are optional. You can create a single-channel or multichannel protocol.

To create a protocol, you configure these settings on the Protocol Setup screens.

The title bar above the Protocol Setup screen displays the protocol name and imager type. Main steps appear as headings in the left pane of each screen. Numbered steps appear under these headings.

Analysis settings consist of the following:

- Detecting lanes and bands
- Analyzing molecular weight

Output settings consist of the following:

- Printing the image
- Printing the report
- Displaying the report
To choose options for a protocol step, select the checkbox to the left of the numbered step. To disable a numbered step, clear its checkbox.

Options for the selected step appear on the right side of the screen.

To determine the optimum imaging time for a chemiluminescent sample, select the signal accumulation mode (SAM) option. SAM acquires a number of images with different imaging times so you can compare the images and then select the optimum imaging time.

Multichannel protocols acquire up to three separate images of a gel or blot, using different illumination, filter, and exposure settings to create a combined image. The Protocol Setup screen displays settings all three channels.

You can also use SAM in a multichannel protocol.
Using Signal Accumulation Mode (SAM)

When you run a chemiluminescence application, you can choose signal accumulation mode (SAM) under Image Exposure on the Gel Imaging protocol setup screen.

SAM simplifies obtaining an optimal image from a chemiluminescent sample. This sample type often requires long integration times to obtain an image that represents the best range of signal.

SAM presents a series of cumulative images with progressively greater signal in each image. To run SAM you must estimate the shortest and longest times expected to generate an image with the appropriate signal intensity. You then decide how many total images to acquire in this period of time.

For example, if the minimum expected time to image the sample is 1 minute and the maximum is 5 minutes, you enter these values (in seconds) in the Setup dialog box. The value you enter in the Total number of images box defines the number of images SAM captures in the defined interval.

In this example, images will be acquired at 1 minute intervals, starting at 1 minute and ending at 5 minutes. The second 1-minute image is added to the first 1-minute image, and the final image is the result of integrating these two images. The third 1-minute image is added to the previous image, and so on, until the last image is presented.

Although SAM is useful for determining the optimum imaging time for a chemiluminescent sample, it results in data that are not as accurate as data from a single image. Signal that is near the intensity of background noise becomes increasingly masked as the number of cumulative images grows. To identify extremely faint signals in an image, reacquire it as a single image, using the time the SAM tool found to be appropriate.

Note: For more information about acquiring and saving SAM images, see Running a Protocol with SAM in this chapter.
Accessing Protocol Setup Screens

To access the default Protocol Setup screen

1. Verify that the name of your imager appears on the status bar.

![Image of status bar](image)

The green check mark indicates that the imager and the computer running Image Lab software are communicating with each other.

2. Click New Protocol on the toolbar.

![Protocols toolbar](image)


The Protocol Setup screen appears. Gel Imaging is selected in the left pane.

![Protocol Setup screen](image)

Gel imaging options appear on the right side of the Protocol Setup screen. The protocol name appears in the title bar. You can change this name when you save the protocol.
Choosing an Application

The term *application* refers to sample type. The sample types consist of the following options:

- Nucleic acid gel, protein gel, or blot
- Detection reagent — dye or stain

In the Gel Imaging Protocol Setup screen, you can choose from a list of predefined applications for common sample types. Each sample type is predefined with optimal acquisition settings.

To use a dye or stain not listed in the Application dropdown menus, you can choose the application type Custom and create a custom application. For more information, see Setting Up a Custom Application on page 38.

Configuring a Single-Channel Protocol


  The Protocol Setup screen appears with Gel Imaging selected. Acquisition options appear in the right pane.

To configure the acquisition settings

1. Under Application, click Select an application type.
2. In the dropdown menu that appears, choose a predefined application.
**Note:** When you select Stain Free Gel, you can also select the gel activation time. See Appendix D, Using Bio-Rad Stain-Free Technology, for more information.

- Under Imaging Area, select the appropriate gel type or enter image area dimensions. The red box to the right represents the imaging area for the selected gel. The gray rectangle represents the imager sample stage.

  **Imaging Area**

  - Select gel type: Bio-Rad PROTEAN II xi Gel
  - Enter image area: 21.4 x 16.0 cm (W x L)

- **Under Image Exposure, select one of the following:**

  - **Auto Exposure** — estimates an optimal exposure time and ensures the best use of the dynamic range.
  - **Intense Bands** — optimizes exposure for all bands.
  - **Faint Bands** — uses a longer exposure time, making faint bands more visible; more prominent bands might be overexposed.
After imaging a gel optimized for automatic exposure, the exposure time used appears on screen. You can use it as a reference to set a manual exposure time.

- **Manual Exposure** — overrides the automatic option. Exposure time can range from 0.001–7,200 seconds. You can view the image exposure time in the Image Info dialog box, which you can access in the Display Toolbox above the on-screen image.

3. *(Optional)* **Signal Accumulation Mode** — when you run a chemiluminescence application, you can also select SAM. To do so, select it under Image Exposure.

4. **Display Options** — two settings enable you to fine-tune image appearance:
  - **Highlight saturated pixels** — display saturated pixels in red, which indicates how much of the gel image is saturated. You can change this option later: select View > Image Transform.
  - **Image color** — select a color scheme for the sample image display. Viewing the image with a different color scheme can make all of its elements more visible. See the chapter, Viewing Images, in the Image Lab Software User Guide for more information.

5. Save the protocol and run these options or go to the analysis or output settings.
Multichannel Protocols

You can create a multichannel protocol, which sequentially acquires up to three separate images of a gel or blot, using different illumination, filter, and exposure settings for each image and also displays a composite of the images. You must configure acquisition settings for at least two channels to create a valid multichannel protocol.

The first Protocol Setup screen, Gel Imaging, presents different predefined application options and acquisition settings for up to three channels.

Configuring a Multichannel Protocol

To access the Protocol Setup screen

1. Verify that the imager name appears on the status bar with a green check mark. This indicates that the imager is communicating with Image Lab.


   The Protocol Setup screen for a multichannel image appears.

   In the left pane, step 1, Gel Imaging, is already selected.
To configure acquisition settings

1. In the right pane of the Protocol Setup screen, click Configure in the Channel 1 box.

   The Configure Channel dialog box appears.

   ![Configure Channel Dialog Box](image)

2. Under Application, click Select and choose a predefined application in the menu that appears.
Note: When you select Stain Free, you can also select the gel activation time. See Appendix D, Using Bio-Rad Stain-Free Technology, for more information.

3. Under Image Exposure, select one of the following:

- **Auto Exposure** — estimates an optimal exposure time and ensures the best use of the dynamic range.
- **Intense Bands** — optimizes exposure for all bands.
- **Faint Bands** — uses a longer exposure time, making faint bands more visible; more prominent bands might be overexposed.
After imaging a gel optimized for automatic exposure, the optimized exposure time appears. You can use it as a reference to set a manual exposure time.

- **Manual Exposure** — manually set an exposure time from 0.001–7,200 seconds.

  **Note:** You can view the image exposure time in the Image Info dialog box, which you can access in the Display Toolbox above the acquired image.

- **Signal Accumulation Mode** — when you run a chemiluminescence application, you can also use signal accumulation mode (SAM).

  To do so, click Signal Accumulation Mode and select Setup to display the Signal Accumulation Setup dialog box.

4. Set the following attributes under Display Options:

- **Highlight saturated pixels** — display saturated pixels in red, which indicates how much of the gel image is saturated. You can change this option later by selecting View > Image Transform.
- **Channel Color** — select a color to display the sample image. Assigning each channel a different color makes it easy to identify the channels.

After you set up the first channel, the second channel box becomes active.

5. Repeat steps 2–4 to set up the remaining channels. The software lists applications that remain available after each selection.

6. (Optional) To change channel settings, click Configure in the channel box and select new settings.

7. Under Imaging Area, select a Bio-Rad gel or enter image dimensions. The red line in the box depicts the imaging area for the gel. The gray rectangle depicts the sample stage.

8. Save the protocol and run it or go to the analysis or output settings.

9. Save the protocol and run it or go to the analysis or output settings.

10. Save the protocol and run it or go to the analysis or output settings.
Configuring Analysis Settings

To analyze a gel or blot automatically, configure analysis settings in the following protocol setup tasks:

- Detect Lanes and Bands
- Analyze Molecular Weight

For information about these settings, see the chapter, Protocols, in the Image Lab Software User Guide.

Configuring Output Settings

When you display a report, a scrollable report screen appears in which you can view the image, acquisition settings, and analysis data. You can view or print a single image or report.

**Note:** You cannot print a report on a thermal printer.

**To specify protocol output**

1. Select Specify Output in the left pane of the Protocol Setup screen.

   Output options appear in the right pane.
2. Choose one of the following:

- Automatically print the image
- Automatically print a report
- Display the report

Image Lab prints to the default printer unless you select another printer.

See the chapter, Generating Reports, in the Image Lab Software User Guide for information about customizing reports.

**Positioning the Gel**

After configuring protocol setup steps, position the gel on the imaging stage and adjust the camera zoom level in Image Lab.

With the Bio-Rad gel alignment template kit you can center four sizes of standard agarose gels and ensure the consistent placement of each gel. See Appendix C, Accessories for more information.

**Tip:** To review protocol settings, click Protocol Summary in the left pane.

**To position a gel**

1. Place a gel on the imaging stage and center it.
2. In Image Lab, click Position Gel in the Protocol Setup screen.
3. The Run screen appears.

4. Adjust the camera zoom level with the slider below the image.

5. Click Run Protocol.

After the protocol runs, the acquired image appears.
Running a Protocol with SAM

Note: SAM can be used only with chemi applications.

You can interrupt the acquisition of images for a SAM-enabled protocol at any time. To do so, click Stop Acquire and Continue with Selected. The acquisition process stops and then continues the protocol with the image you select. Images already acquired are discarded.

To view a SAM image in the workspace

► Click its thumbnail.

To save the image you want to analyze

1. Review the images and identify the image you want to use in your analysis.
   
   **Important:** Save the image you want to keep before you continue running the protocol. When you click Select Image and Continue, the selected image is saved and all unsaved images are deleted.

2. Select the image you want and click Select Image and Continue.
   
   Image Lab continues to the next step in the protocol using the image you selected.
Saving SAM Images

To save a SAM image

1. Right-click its thumbnail and click Save.
2. In the Save File dialog box, accept the default file name or enter another name. Click Save.

To save all SAM images

1. Right-click a SAM image and select Save All.
2. In the Select Directory dialog box, enter a folder name and click Choose.

The images are saved in the specified folder. The name of the file includes the user name, timestamp, and exposure time. For example:

John Doe 2015-05-01 15 hr 44 min_Exposure_5.0sec.

Setting Up a Custom Application

When you create a protocol, Image Lab displays a list of application types and predefined applications for acquiring images. To use a dye or stain not listed in the Application dropdown menus, you can choose the application type Custom and create a custom application. Also choose Custom to do the following:

- Choose a previously saved custom application
- Edit or rename a custom application

Note: If you are not sure how to configure a custom application for a dye or stain, contact Bio-Rad Technical Support.

To create a custom application

2. Under Application, click Select and choose Custom on the menu that appears.
The Manage Custom Applications dialog box appears.

3. Click New.

4. Enter a unique application name.

5. Under Application Settings, select a light source, filter, and image color.

   Viewing the image with a different color scheme can make all of its elements more visible.

6. Select a binning setting.

   A higher binning setting combines pixels to increase the amount of signal without increasing noise. A higher setting provides optimal sensitivity for low-light applications such as chemiluminescence, but it reduces image resolution.
Editing a Protocol

You can open a protocol, change its settings, and save it with another name. You can also disable a step in the saved protocol. When you edit a default protocol and save it with a new name, the default protocol is unaffected.

See the chapter, Protocols, in the Image Lab Software User Guide for more information.
3 System Calibration

When the imager is installed, it is calibrated using a calibration wizard. For detailed instructions, see the installation guide in the imager installation kit.

The Image Lab™ software instrument calibration wizard provides several options required to automate the system and prevent focus problems. Each of these calibrations affects the system as follows:

- **Focus Calibration** — allows automated focus settings at any zoom point, using a software algorithm. This ensures that the focus remains correct whether you view an entire sample or an area of interest.

- **Focus Calibration with Height Offset** — takes the tallest of the available conversion screens into account and extrapolates values for the others so that focus remains optimal for the screen in use. Checking the Illumination options on the Instrument Setup screen instructs Image Lab to generate the focus calibration offset. Focus calibration offset does not change flat field calibrations.

- **UV Flat Field Calibration** — generates the flat field correction profiles required for the UV light source. The orange flat field generates a flat field profile for UV. Because of this calibration, the images have more accurate quantity reporting and backgrounds of even intensity.

- **Lens Flat Field Calibration** — corrects for the intensity roll-off inherent in any lens.

- **White Conversion Screen Calibration** — generates a flat field correction profile required for the white light conversion screen.
Recalibrating the Imager

When you add light sources or filters to the ChemiDoc™ MP imager, you must recalibrate the imager.

To recalibrate the imager
1. In Image Lab, click Edit > Instrument Setup.
2. The Instrument Setup dialog box appears.
3. (Optional) To add a new light conversion screen, select the appropriate box in the Illumination Options field. For more information, see Appendix C, Accessories.

4. For any other changes to the optical pathway, perform a flat field calibration. To do so, click Reset in the Instrument Calibration > Flat Field group and follow the on-screen instructions.

5. Wait for the software to prompt you to recalibrate the new illumination sources.

6. Click OK.
A Maintenance

UV Transilluminator Lamp and Starter Replacement

*Note:* Always keep the UV filter surface clean from the chemical agents used as gel dyes. Use protective gloves when touching the UV transilluminator cover.

Depending on usage, the UV bulbs and starters can last for many years. Replace bulbs when you notice them flickering. If a bulb does not turn on when it is new or moved, replace the bulb starter and test the bulb again.

Three types of bulbs are available. The catalog numbers are listed in *Ordering Information on page 60*. The standard bulb is 302 nm. Optionally, the 254 nm bulb is used for cross-linking protein, and the 365 nm bulb is used to minimize denaturing of DNA.

To replace the lamps

1. Turn off the power.
2. Disconnect the power cord from the universal hood.
3. Remove the four screws located on the left/right sides of the transilluminator cover.
4. Remove the cover with the UV glass by sliding it forward, then lifting up.
5. Place it on a nonabrasive surface so that the glass does not get scratched or damaged.

*Note:* Do not put the UV cover directly on the bench. Wear gloves when touching the lamps.
6. Rotate the lamp until it becomes loose and the pins come to a vertical position.

7. Remove the lamp. Install the new lamp by rotating so that the pins are horizontal and the lamp is tight.

8. Remove the starter by rotating it counterclockwise, and then pull it out.

9. Insert a new starter into the holder and rotate clockwise.

10. Reassemble the cover and retighten the screws on both sides.
Fuse Replacement

Always unplug the instrument before changing or checking the fuses.

This unit is protected by two fuses (5 x 20 mm, 2 A Slo-Blo). The fuses are located in fuse holders housed in the power entry module. This module is located on the right side of the back of the universal hood.

To replace the fuses

1. Unplug the main power cable from the power outlet.
2. Use a flat screwdriver to turn the slotted front of each fuse holder counterclockwise; the holder pops out so you can extract the fuse.
3. Remove the blown fuses and replace them with two new fuses (catalog #9008935).
4. Slide each fuse holder into the power entry module until it snaps in place.
Maintenance
# Troubleshooting

The following table lists potential problems and suggested solutions.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera does not respond/camera not found</td>
<td>■ Power to the camera may be turned off.</td>
<td>■ Turn on the power to the camera.</td>
</tr>
<tr>
<td></td>
<td>■ The camera cables might not be seated properly.</td>
<td>■ Make sure that all cables are connected as shown in the Installation Guide.</td>
</tr>
<tr>
<td></td>
<td>■ The software driver for the camera is missing.</td>
<td>■ If the camera driver is not present, reload the camera driver from the Image Lab™ software CD.</td>
</tr>
<tr>
<td></td>
<td>■ Computer power-saving modes might be interfering with the camera driver.</td>
<td>■ Disable the power-saving modes on the computer.</td>
</tr>
<tr>
<td></td>
<td>■ The cables might be defective.</td>
<td>■ Replace the cables.</td>
</tr>
<tr>
<td></td>
<td>■ The camera might be defective.</td>
<td>■ Replace the camera.</td>
</tr>
<tr>
<td>Horizontal stripes in image when using the UV mode</td>
<td>■ The emission filter might not be positioned properly.</td>
<td>■ Cycle power to the Universal Hood III so that the filter wheel is positioned properly.</td>
</tr>
<tr>
<td>Image is not visible on the monitor</td>
<td>■ The monitor settings are incorrect.</td>
<td>■ See your computer manual for the proper settings.</td>
</tr>
<tr>
<td></td>
<td>■ The lens cap is attached.</td>
<td>■ Remove the lens cap.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Printout does not look like the monitor image | ■ The monitor settings are wrong.  
■ The printer settings are wrong. | ■ See your monitor manual for the appropriate settings.  
■ See your printer manual for the appropriate settings. |
| Light leakage into the darkroom | ■ The lens body is not seated properly against the gasket on the hood’s adapter plate. | ■ Loosen the thumbscrew and seat the lens properly against the gasket on the hood’s adapter plate. |
| Unable to focus on the sample using white light conversion screen | ■ Focus is not calibrated for samples using this light source. | ■ Select Edit > Instrument Setup to recalibrate the focus for use with this accessory. |
| Lens limits seem artificially restricted | ■ The camera lens is not seated properly on the lens mounting plate. | ■ Re-seat the camera on the lens mounting plate. |
C Accessories

Calibrating Accessories

When you install accessories during initial installation of the imaging system, you must run the one-time Instrument Calibration wizard to calibrate the system. Refer to the installation guide for instructions.

You must also recalibrate the imager before using new conversion screens, light sources, or filters. See Chapter 3, System Calibration for more information about calibrating new accessories.

Installing Optional Accessories

Epi Light Modules

Epi light modules are available for the ChemiDoc™ MP imager in three colors: red (catalog #1708283), blue (catalog #1708285), and green (catalog #1708284). For installation instructions, see Installing an Epi Light, an instruction sheet that accompanies each module.
UV/White Light Conversion Screen

This optional white light conversion screen (catalog #1708289) converts the UV light generated in the universal hood to white light. The imager must be calibrated to use the white light conversion screen.

The UV/White Light conversion screen is held in place by adhesive-backed edge guides. After the edge guides are installed, the conversion screen remains centered and does not slide, even when you close the drawer rapidly.
To install the UV/White Light conversion screen

**Important:** Do not remove the adhesive paper tape from the edge guides until step 2. You cannot reposition the adhesive surfaces of the edge guides once they are set in place.

1. Holding the screen right side up with the paper taped edge guides underneath, practice positioning the edge guides so that they touch the inside of the transilluminator drawer front and fit over the edge of the metal transilluminator border (shown in red).

2. When you have positioned the edge guides to your liking, remove the paper tape from under each guide.

3. Carefully press each edge guide into position.

4. To visualize a sample using the screen, place the screen between the edge guides.

5. Use the gel alignment template kit to center the gels on top of the screen consistently. For more information, see To use a gel alignment template with a conversion screen on page 58.
To calibrate the imager

1. In Image Lab™ software, choose Edit > Instrument Setup.
2. Select the White Light Conversion Screen checkbox under Illumination Options.
   When calibration finishes, the imager is ready to acquire images.

To image a gel with the white light conversion screen

1. Center the conversion screen on the imager stage.
2. Center the samples on top of the conversion screen.
3. Image the gel.

For more information, see Chapter 3, Acquiring Images.
XcitaBlue Conversion Screen

The optional XcitaBlue™ conversion screen kit (catalog #1708182) converts UV to blue light, so you can visualize DNA samples while protecting them against UV damage.

The XcitaBlue conversion screen is held in place by adhesive-backed edge guides. After the edge guides are installed, the conversion screen remains centered and does not slide even when you close the drawer rapidly.

Note: After you install the conversion screen, you must calibrate the imager.

To install the XcitaBlue conversion screen

Important: Do not remove the adhesive paper tape from the edge guides until step 2. You cannot reposition the adhesive surfaces of the edge guides once they are set in place.

1. Holding the screen right side up with the paper taped edge guides underneath, practice positioning the edge guides so that they touch the inside of the
transilluminator drawer front and fit over the edge of the metal transilluminator border (shown in red).

2. Position the edge guides to your liking.
3. Remove the paper tape from under each guide.
4. Carefully press each edge guide into position.
5. To visualize a sample using the screen, place the screen between the edge guides.
6. Use the gel alignment template kit to center the gels on top of the screen consistently.

To calibrate the imager

1. In Image Lab software, choose Edit > Instrument Setup.
2. Under Illumination Options, select the XcitaBlue Conversion Screen checkbox.
When calibration finishes, the instrument is ready to acquire images.

To image a gel on the blue light conversion screen

1. Center the conversion screen on the imaging stage.
2. Center the samples on top of the conversion screen.
3. Select a protocol and image the gel.

For more information, see Chapter 3, Acquiring Images.

**Gel Alignment Template Kit**

The Bio-Rad gel alignment template kit (catalog #1708184) enables you to center four sizes of standard agarose gels quickly and ensures the consistent placement of each gel.

![Gel Alignment Template Kit](image)

**Note:** Using the gel alignment template kit does not affect imager calibration.

The kit contains

- Magnetic locator frame
- Instruction sheet
- Alignment guides for the following gel trays:
C | Accessories

- Sub-Cell® GT UV-transparent mini-gel tray, 7 x 7 cm
- Sub-Cell GT UV-transparent wide mini-gel tray, 15 x 7 cm
- Sub-Cell GT UV-transparent mini-gel tray, 7 x 10 cm
- Sub-Cell GT UV-transparent gel tray, 15 x 10 cm

The gel alignment templates fit exactly into the XcitaBlue conversion screen frame (catalog #1708182).

**To use a gel alignment template with a conversion screen**

1. Remove the magnetic locator frame if it is on the transilluminator.
2. Place the conversion screen on the transilluminator.
3. Place the gel alignment template that matches the size of the sample tray or agarose gel inside the conversion screen frame.
4. Place the gel or gel tray into the open area of the template.

**To use a gel alignment template with the magnetic locator frame**

1. Place the magnetic locator frame over the transilluminator with the magnetic side down.
2. Match the corners of the magnetic locator frame with the edges of the transilluminator.
3. Position the magnetic locator frame so that its UV symbol matches the direction of the UV symbol on the imager.

For example:

![UV symbols](image)

4. Place the gel alignment template that matches the size of the sample tray or agarose gel into the magnetic locator frame.
5. Place the gel or gel tray into the open area of the template.
1. The Instrument Setup dialog box appears.

2. Under Flat Field, click Reset and then click OK.
## Ordering Information

The following table lists catalog numbers and descriptions for all parts available for the ChemiDoc MP imager, plus all optional accessories and replacement parts. For more information, see the Bio-Rad catalog.

### Table 3. Ordering information

<table>
<thead>
<tr>
<th>Catalog #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1708280</td>
<td>ChemiDoc MP imaging system</td>
</tr>
<tr>
<td>1708255</td>
<td>ChemiDoc MP camera with motorized zoom lens</td>
</tr>
<tr>
<td>1709690</td>
<td>Image Lab software, Windows/Mac</td>
</tr>
<tr>
<td>1708001</td>
<td>UV/White light conversion screen (UV to white light)</td>
</tr>
<tr>
<td>1708182</td>
<td>XcitaBlue (UV to blue light) conversion screen kit, without standard detection filter</td>
</tr>
<tr>
<td>1708283</td>
<td>Kit, Red LED Module</td>
</tr>
<tr>
<td>1708284</td>
<td>Kit, Green LED Module</td>
</tr>
<tr>
<td>1708285</td>
<td>Kit, Blue LED Module</td>
</tr>
<tr>
<td>1703759</td>
<td>Bio-Rad fluorescent ruler</td>
</tr>
<tr>
<td>1703760</td>
<td>Gel cutter ruler</td>
</tr>
<tr>
<td>1708184</td>
<td>Gel alignment template kit</td>
</tr>
<tr>
<td>1708026</td>
<td>Image Lab focus calibration target</td>
</tr>
<tr>
<td>1708027</td>
<td>Image Lab flat fielding disc</td>
</tr>
<tr>
<td>1708185</td>
<td>XcitaBlue viewing goggles</td>
</tr>
<tr>
<td>1707813</td>
<td>Sample holders for gels</td>
</tr>
<tr>
<td>1708081</td>
<td>Filter, standard emission, 62 mm</td>
</tr>
<tr>
<td></td>
<td><strong>Lamps</strong></td>
</tr>
<tr>
<td>1001361</td>
<td>UVB lamp, 302 nm (1 each)</td>
</tr>
<tr>
<td>1708097</td>
<td>302 nm lamp kit, (6 lamps)</td>
</tr>
<tr>
<td>1706887</td>
<td>365 nm lamp kit, (6 lamps)</td>
</tr>
<tr>
<td>Catalog #</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>9008935</td>
<td>Fuse T 2 A, 250 V, quantity 10</td>
</tr>
<tr>
<td>9000234</td>
<td>Fuse T 4 A, 250 V, quantity 10</td>
</tr>
<tr>
<td></td>
<td><strong>Universal Hood III</strong></td>
</tr>
<tr>
<td>1002787</td>
<td>Universal Hood feet, quantity 4</td>
</tr>
<tr>
<td>1708068</td>
<td>UV Shield for Universal Hood</td>
</tr>
<tr>
<td></td>
<td><strong>Connection Cables</strong></td>
</tr>
<tr>
<td>9310071</td>
<td>Cable, USB, Type A to B, 10 ft</td>
</tr>
<tr>
<td>9010064</td>
<td>Cable, USB, Type A to B, 6 ft</td>
</tr>
</tbody>
</table>
Using Bio-Rad Stain-Free Technology

Bio-Rad stain-free gels eliminate the time-consuming staining and destaining steps required by other protein detection methods. Stain-free gels include unique trihalo compounds that allow rapid fluorescent detection of proteins with the ChemiDoc™ MP imager without staining.

When using Image Lab™ software, the ChemiDoc MP imager is stain-free enabled to image the following gels:

- Criterion™ TGX Stain-Free™ precast gels
- Criterion Stain Free™ precast gels
- Mini-PROTEAN® TGX Stain-Free™ precast gels
- TGX Stain-Free™ FastCast™ acrylamide solutions for handcast gels

When trihalo compounds in the gels encounter tryptophan residues, a UV light-induced reaction produces fluorescence, which can be easily detected by the imager in gels or on low fluorescence polyvinyl difluoride (PVDF) membranes. Activation of the trihalo compounds in the gels adds 58 Da moieties to available tryptophan residues and is required for protein visualization. Proteins that do not contain tryptophan residues cannot be detected using this technology. The sensitivity of stain-free gels is comparable to staining with Coomassie Brilliant Blue for proteins with a tryptophan content >1.5%; sensitivity superior to Coomassie staining is possible for proteins with a tryptophan content >3%.

The benefits of stain-free technology include

- Elimination of staining and destaining steps for faster time to results
- No background variability within a gel or between gels (as is often seen with standard Coomassie staining)
- Elimination of the need for acetic acid and methanol in staining and destaining, which reduces organic waste
- Visualization of transferred or blotted proteins on low fluorescence PVDF membranes

**Stain-Free Workflow**

For detailed information about the Activate/image gels step, refer to Chapter 3, Acquiring Images. For all other workflow steps, refer to the Criterion™ Precast Gels Instruction Manual and Application Guide (bulletin #4110001) or to the Mini-PROTEAN® Precast Gels Instruction Manual and Application Guide (bulletin #1658100).
Electrophoresis with Stain-Free Gels

Stain-free gels are made and packaged without sodium dodecyl sulfate (SDS), allowing them to be used for both SDS and native polyacrylamide gel electrophoresis (PAGE) applications.

To perform electrophoresis with stain-free gels
1. Prepare the sample and running buffers.
2. Set up the electrophoresis cell.
3. Perform the run.

Imaging Gels

Use unstained standards with stain-free gels, as some prestained standards are not compatible with stain-free technology. To monitor electrophoresis, use a 1:1 mixture of unstained and prestained standards.

Setting up a protocol for stain-free gels is similar to setting up protocols for other applications. Follow the instructions in Creating a Protocol on page 20. Choose one of the following activation times based on the sample and the purpose of your experiment:

- **Gels used in blotting** — use 1 min activation for optimal results when performing western blotting followed by immunodetection.
- **Good sensitivity** — use 2.5 min activation when samples are abundant and when a fully optimized signal-to-noise ratio is not necessary.
- **Best sensitivity** — use 5.0 min activation for detection of proteins that are in low concentration and for the best quantitation of the maximum number of bands. Because the reaction is near completion after 5 min, this method offers an optimal signal-to-noise ratio.

**Note:** If the gel has been activated for 2.5 min, activating it for another 2.5 min might improve it. But activating an image for more than 5 min will not.
Imaging Blots

To blot stain-free gels, use standard blotting procedures as described in the instruction manual you are using. Use only PVDF membranes with low background fluorescence, as membranes other than low fluorescence PVDF can result in high background or low sensitivity with the imager.

To assess transfer efficiency, be sure to activate and visualize the gel using the imager before transfer.